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Guidance for Industry: Availability of Templates for Toxicology Data


Introduction to the Template for in vitro Bacterial Reverse Mutation (Ames) Test
March 2004
GENERAL INSTRUCTIONS:  You can navigate the template either by pressing the "arrow" keys or by using the mouse.  The sections expand as you type.  When you begin filling out a template, save it with a filename different from that of the template itself, so that you'll keep the blank template in your original file for future use.

To move quickly down the template to a specific section, click on the "View" menu, then "Document Map".  If you then click on a specific section name in the left-hand window, that section of the template will appear on the main screen.  Then close the left-hand screen to work on the template by selecting "View", "Document Map" again. 

In the event that the study contains additional types of information included as part of the experiment, you can add sections (with appropriate re-numbering) as needed.  This template will also accommodate tables prepared in Microsoft Excel and Microsoft Access.

Many of the yellow highlighted areas in headings contain comments in a pop-up balloon or as hidden text.  These are suggestions or instructions relevant to that particular section.  They may be viewed either by moving your mouse over the yellow highlighted areas or clicking on the ‘View’ menu, then ‘View Comments’ or ‘Markup’. To prevent the comments from appearing in the printed document, cancel the ‘Markup’ command or select ‘Document’ under ‘Print what’ when you issue the ‘Print’ command.

The templates were created in Microsoft Office 2000 software applications.  The comment sections in the templates may perform optimally with the same versions of the software applications.
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GENETIC TOXICOLOGY STUDIES: 

IN VITRO BACTERIAL REVERSE MUTATION (AMES) TESTS

date of submission:

title of petition or notification:  


name and address of petitioner or notifier: 


I.
IDENTIFICATION OF TEST

A. test file location (volume and page number(s)): 


B. test title/report number: 


C. name of author or director of test: 


D. name and address of testing laboratory: 


E. date of test report: 


F. dates test conducted: 


G. objective of test: 


H. comments: 


II.
GOOD LABORATORY PRACTICE

A. is a good laboratory practice (glp) compliance statement included? 

B. is a quality assurance (qa) statement included? 


C. availability and location of original data/specimens/test substance: 

III.
MATERIALS AND METHODS
A. TEST SUBSTANCE
1. chemical name: 


2. cas registry name: 


3. cas registry number: 
 
4. structure: 



5. purity: 


6. impurities:  
 

7. physical description: 


8. stability: 


9. comments: 


B. TEST SUBSTANCE AS ADMINISTERED

10. batch/lot number: 


11. vehicle used: 

12. tested for concentration? 


13. tested for stability? 


14. problems with storage? 


C. EXPERIMENTAL 
methodology

15. bacterial strains used
: 


a salmonella typhimurium: 


	
	TA98
	
	TA100
	
	TA1535
	
	TA1537

	
	TA97
	
	TA97a
	
	TA1538
	
	TA102

	
	  Other S. Typhimurium strains (specify):



b escherichia coli: 


	
	WP2(uvrA)

	
	Other E. coli strains (specify):


c were the strains: 


	Checked for appropriate genetic markers?

	
	Yes
	
	No or not stated

	Properly maintained?
	
	Yes
	
	No or not stated


16. in vitro metabolic activation system (s9 mix):  


d composition: 
 


	COMPONENT
	CONCENTRATION OR AMOUNT (Unit)
	COMMENT

	
	
	

	
	
	

	
	
	

	S9 Fraction 

(Details on induction, see below)
	
	


e S9 fraction: 


	INDUCED

OR NOT
	INDUCER USED
	ANIMAL

INDUCED*
	ANIMAL TISSUE USED FOR S9 FRACTION

	
	Induced
	
	Aroclor 1254
	
	Rat
	
	Liver

	
	
	
	Phenobarbital
	
	Mouse
	
	Lung

	
	
	
	Other (specify):


	
	Hamster
	
	Other (specify):



	
	
	
	
	
	Other (specify):


	
	

	
	Non-induced
	
	None
	
	None
	
	None


* Specify strain and sex of the animal induced:  Strain: 

Sex:


17. control agents: 



f negative control: 


g solvent/final concentration: 


h positive controls without metabolic activation
: 


	TESTER STRAINS

	CHEMICAL
	DOSE ((g/PLATE)

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	

	
	
	


i positive controls with metabolic activation: 


	TESTER STRAINS
	CHEMICAL
	DOSE ((g/PLATE)

	
	
	

	
	
	

	
	
	


j comments on positive controls: 


18. test compound concentrations used: 


k preliminary cytotoxicity/range-finding 
test: 


	CONDITION
	TEST COMPOUND
	CONCENTRATION/SOLVENT

	NON-ACTIVATED (-S9)
	
	

	ACTIVATED         (+S9)
	
	


l mutagenicity test(s)
: 



	CONDITION
	TEST COMPOUND
	CONCENTRATION/SOLVENT

	INITIAL


	- S9 
	
	

	
	+S9 
	
	

	second confirmatory
	- S9 
	
	

	
	+S9 
	
	

	third confirmatory
	- S9 
	
	

	
	+S9 
	
	


19. test procedure used: 


	
	Standard plate incorporation test

	
	Preincubation test
	Time:
	Temperature:

	
	Other (describe)


20. protocol
: 



21. statistical analysis
: 


22. evaluation criteria
: 


III.
RESULTS

D. PRELIMINARY CYTOTOXICITY (RANGE-FINDING) TEST 

23. table 1.  summary of preliminary cytotoxicity (range-finding)test
	STRAIN
	S9
	DOSE RANGE ((g/PLATE)
	HIGHEST

MEAN NUMBER REVERTANTS /PLATE

(AT DOSE?)
	BACKGROUND LAWN

	HISTORICAL CONTROL RANGE

	TA100
	-
	
	
	
	

	TA100
	-
	Solvent control
	
	
	

	TA100
	-
	Positive control
	
	
	

	TA100
	+
	
	
	
	

	TA100
	+
	Solvent control
	
	
	

	TA100
	+
	Positive control
	
	
	

	WP2 (uvrA)
	-
	
	
	
	

	WP2 (uvrA)
	-
	Solvent control
	
	
	

	WP2 (uvrA)
	-
	Positive control
	
	
	

	WP2 (uvrA)
	+
	
	
	
	

	WP2 (uvrA)
	+
	Solvent control
	
	
	

	WP2 (uvrA)
	+
	Positive control
	
	
	


24. comments on cytotoxicity (range-finding) test
: 


E. MUTATION TESTS


25. table 2.  summary of initial mutation test


	STRAIN
	S9
	DOSE RANGE ((g/PLATE)
	HIGHEST

MEAN NUMBER REVERTANTS /PLATE

(AT DOSE?)
	BACKGROUND LAWN

	DOSE RESPONSE?

	TA98
	-
	
	
	
	

	TA98
	-
	Solvent control
	
	
	

	TA98
	-
	Positive control
	
	
	

	TA98
	+
	
	
	
	

	TA98
	+
	Solvent control
	
	
	

	TA98
	+
	Positive control
	
	
	

	TA100
	-
	
	
	
	

	TA100
	-
	Solvent control
	
	
	

	TA100
	-
	Positive control
	
	
	

	TA100
	+
	
	
	
	

	TA100
	+
	Solvent control
	
	
	

	TA100
	+
	Positive control
	
	
	

	TA1535
	-
	
	
	
	

	TA1535
	-
	Solvent control
	
	
	

	TA1535
	-
	Positive control
	
	
	

	TA1535
	+
	
	
	
	

	TA1535
	+
	Solvent control
	
	
	

	TA1535
	+
	Positive control
	
	
	

	TA1537
	-
	
	
	
	

	TA1537
	-
	Solvent control
	
	
	

	TA1537
	-
	Positive control
	
	
	

	TA1537
	+
	
	
	
	

	TA1537
	+
	Solvent control
	
	
	

	TA1537
	+
	Positive control
	
	
	

	WP2 (uvrA)
	-
	
	
	
	

	WP2 (uvrA)
	-
	Solvent control
	
	
	

	WP2 (uvrA)
	-
	Positive control
	
	
	

	WP2 (uvrA)
	+
	
	
	
	

	WP2 (uvrA)
	+
	Solvent control
	
	
	

	WP2 (uvrA)
	+
	Positive control
	
	
	


26. comments on initial mutation 
test: 


27. table 3.  summary of second (confirmatory) mutation test 

	STRAIN
	S9
	DOSE RANGE ((g/PLATE)
	HIGHEST

MEAN NUMBER REVERTANTS /PLATE

(AT DOSE?)
	BACKGROUND LAWN

	DOSE RESPONSE?

	TA98
	-
	
	
	
	

	TA98
	-
	Solvent control
	
	
	

	TA98
	-
	Positive control
	
	
	

	TA98
	+
	
	
	
	

	TA98
	+
	Solvent control
	
	
	

	TA98
	+
	Positive control
	
	
	

	TA100
	-
	
	
	
	

	TA100
	-
	Solvent control
	
	
	

	TA100
	-
	Positive control
	
	
	

	TA100
	+
	
	
	
	

	TA100
	+
	Solvent control
	
	
	

	TA100
	+
	Positive control
	
	
	

	TA1535
	-
	
	
	
	

	TA1535
	-
	Solvent control
	
	
	

	TA1535
	-
	Positive control
	
	
	

	TA1535
	+
	
	
	
	

	TA1535
	+
	Solvent control
	
	
	

	TA1535
	+
	Positive control
	
	
	

	TA1537
	-
	
	
	
	

	TA1537
	-
	Solvent control
	
	
	

	TA1537
	-
	Positive control
	
	
	

	TA1537
	+
	
	
	
	

	TA1537
	+
	Solvent control
	
	
	

	TA1537
	+
	Positive control
	
	
	

	WP2 (uvrA)
	-
	
	
	
	

	WP2 (uvrA)
	-
	Solvent control
	
	
	

	WP2 (uvrA)
	-
	Positive control
	
	
	

	WP2 (uvrA)
	+
	
	
	
	

	WP2 (uvrA)
	+
	Solvent control
	
	
	

	WP2 (uvrA)
	+
	Positive control
	
	
	


28. comments on second mutation 
test: 


29. table 4.  summary of third (confirmatory) mutation test (optional)
: 

	STRAIN
	S9
	DOSE RANGE ((g/PLATE)
	HIGHEST

MEAN NUMBER REVERTANTS /PLATE

(AT DOSE?)
	BACKGROUND LAWN

	DOSE RESPONSE?

	TA98
	-
	
	
	
	

	TA98
	-
	Solvent control
	
	
	

	TA98
	-
	Positive control
	
	
	

	TA98
	+
	
	
	
	

	TA98
	+
	Solvent control
	
	
	

	TA98
	+
	Positive control
	
	
	

	TA100
	-
	
	
	
	

	TA100
	-
	Solvent control
	
	
	

	TA100
	-
	Positive control
	
	
	

	TA100
	+
	
	
	
	

	TA100
	+
	Solvent control
	
	
	

	TA100
	+
	Positive control
	
	
	

	TA1535
	-
	
	
	
	

	TA1535
	-
	Solvent control
	
	
	

	TA1535
	-
	Positive control
	
	
	

	TA1535
	+
	
	
	
	

	TA1535
	+
	Solvent control
	
	
	

	TA1535
	+
	Positive control
	
	
	

	TA1537
	-
	
	
	
	

	TA1537
	-
	Solvent control
	
	
	

	TA1537
	-
	Positive control
	
	
	

	TA1537
	+
	
	
	
	

	TA1537
	+
	Solvent control
	
	
	

	TA1537
	+
	Positive control
	
	
	

	WP2 (uvrA)
	-
	
	
	
	

	WP2 (uvrA)
	-
	Solvent control
	
	
	

	WP2 (uvrA)
	-
	Positive control
	
	
	

	WP2 (uvrA)
	+
	
	
	
	

	WP2 (uvrA)
	+
	Solvent control
	
	
	

	WP2 (uvrA)
	+
	Positive control
	
	
	


30. comments on third mutation test (optional): 


V.
OVERALL ASSESSMENT AND SUMMARY
F. ASSESSMENT OF STUDY

G. SUMMARY

VI.
REFERENCES






�PAGE \# "'Page: '#'�'"  ����FDA’s recommendations for conducting a bacterial reverse mutation test are contained in Redbook 2000, IV.C.1.a. Bacterial Reverse Mutation Test � HYPERLINK "http://www.cfsan.fda.gov/~redbook/redivc1a.html" ��http://www.cfsan.fda.gov/~redbook/redivc1a.html�.  This template is for the S. typhimurium  Test (Ames Test), the most commonly used reverse mutation test.  In addition to the S. typhimurium  TA strains, an E. coli strain WP2 or its variants are often included in the test.  The TA strains detect a reversion event from Histidine dependence to Histidine independence while the WP2 strains do the same for Tryptophan dependence.


�Indicate Yes or No for the Questions A and B.  However, you may want to elaborate on the type of GLP compliance (USFDA, OECD, etc.) or make other notations.


�PAGE \# "'Page: '#'�'"  ���� If the molecular structure is not provided with the test, it may be available from a source such as Chemfinder (� HYPERLINK "http://www.chemfinder.com" ��http://www.chemfinder.com�) or ChemIDplus (� HYPERLINK "http://chem.sis.nlm.nih.gov/chemidplus/" ��http://chem.sis.nlm.nih.gov/chemidplus/�).  The CAS number is the preferred search term if you have it, otherwise try the common name or any synonyms. If the correct structure is found on Chemfinder or ChemIDplus, the image can be downloaded and inserted into your report.  If the structure is not available, enter ‘Not available’.





�Indicate how the test substance was administered and whether any vehicle was used to dissolve/suspend the test substance (e.g., dissolved in dimethylsulfoxide).  Describe how testings for concentration and stability were done.  How was the test substance in vehicle, etc., stored before being used in the test? Note anything that was not normal or routine.





�Provide adequate details so the information can be used to help prepare a report. Use the comments to indicate additional information about the experimental design.  To change the table, place cursor in the row or column that you wish to modify, then from the ‘Table’ menu, use ‘Select Row’ or ‘Select Column’ to highlight the row or column that you wish to change, and use the ‘delete’ or ‘insert’ functions to make your changes.





�PAGE \# "'Page: '#'�'"  ����Put an X in the box to the left of each strain used and type in any other strain used.





�PAGE \# "'Page: '#'�'"  ����e.g. rfa mutations, R factor





�PAGE \# "'Page: '#'�'"  ����List the components and concentrations of cofactor solutions as well as the amount of S9 fraction in S9 mix.  If the S9 mix was purchased, provide details.





�PAGE \# "'Page: '#'�'"  ����Enter all strains treated with a given positive control at the same dose.  If a given positive control agent was used at different doses in different strains, add a separate row for each dose.  If all table rows are used, add additional rows by clicking the left mouse button in the last cell (bottom right) and pressing the TAB key.





�Frequently 2-Aminoanthracene (2-Anthramine) is used as the positive control without activation in all tester strains. If this is the case, just enter “All Strains”, otherwise enter the individual strains treated with a given positive control at the same dose.





�PAGE \# "'Page: '#'�'"  ����If no preliminary cytotoxicity test was performed, enter “not performed.”





�PAGE \# "'Page: '#'�'"  ����If more than one mutagenicity test was conducted, list the concentrations used in each test.





�PAGE \# "'Page: '#'�'"  ����Give a brief description of the experimental protocol including tester strain preparation, media used, cell numbers, number of plates/dose/activation condition, incubation times and colony counting method.





�PAGE \# "'Page: '#'�'"  ����Briefly describe the method used.  Usually in the Salmonella test, the criterion for a positive response is given as a fold-increase over the solvent control (two- or three-fold increase depending on the strain) and no statistical analysis is used. In that case, just enter “not conducted.” 





�PAGE \# "'Page: '#'�'"  ����Enter the criteria for an acceptable test and for a positive and negative response.  Were the revertant colonies counted with an automatic counter or manually?





�PAGE \# "'Page: '#'�'"  ����TA100 and WP2 (uvrA) are frequently used in the cytotoxicity test; however, if other strains were used, modify the table as required using the standard Word commands. 





�PAGE \# "'Page:4 '#'�'"  ����e.g. normal, thin, absent





�PAGE \# "'Page: '#'�'"  ����Briefly describe the results of the cytotoxicity (range-finding) test and the basis for the selection of concentrations used in the mutation tests.  For example, “in the absence of any cytotoxic effect, the limit dose of 5 mg/plate was used as the upper dose” or “the upper dose was limited by cytotoxicity or solubility”.


�PAGE \# "'Page: '#'�'"  ����The five most commonly used tester strains are entered in the table as defaults; however, the table should be modified to reflect the strains actually used in a given test.





�PAGE \# "'Page: '#'�'"  ����Enter the description of the background lawn: e.g. normal, thin, absent.





�PAGE \# "'Page: '#'�'"  ����Briefly summarize the results of the mutation test with the goal of clarifying or expanding on the data in the table or adding something pertinent not included in the table.  For example, comments such as the following could be included:  


Cytotoxicity as based on a reduction in the background number of revertants per plate was seen in strain(s) at dose(s) of X – Y.  


A precipitate was seen at concentrations of X and above.


A two-fold or greater increase in the number of revertants/plate was seen in strain(s) at X mg/plate.


A mutagenic effect was seen only in strain(s) indicating a frameshift method of action.


The positive and solvent control values were appropriate for the respective strains.


Based on results of the first mutation test, test material concentrations of X – Y were chosen for the second mutation test.





Essentially, this summary is a statement of conclusions drawn from the test.





�PAGE \# "'Page: '#'�'"  ����Enter the description of the background lawn: e.g. normal, thin, absent.





�PAGE \# "'Page: '#'�'"  ����Briefly summarize the second test as you did the first test. Do the results of the second test agree or disagree with those of the first test?


�PAGE \# "'Page: '#'�'"  ����Delete the table and sections III.B.5-6 if not needed.  


�PAGE \# "'Page: '#'�'"  ����Enter the description of the background lawn: e.g. normal, thin, absent.
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